
wInformant Help Index
Copyright © 1994 by Joseph M. Albanese.    All rights reserved.
wInformant™ is a trademark of Joseph M. Albanese.

Click on any of the above buttons with a mouse, or tab to a button and press enter, to jump to the associated topic.

Getting Started
Introduction
Moving Around
Menu Commands

Registration
About Shareware
Why Register?
How to Register
Registration Form

WARNING:    Unauthorized reproduction, distribution or tampering with this program, or any portion of it, may result 
in severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under the law.



About Shareware

This software is NOT free.    It is copyrighted material; however, it is distributed as 
shareware.    As such, the UNREGISTERED SHAREWARE version may be freely copied and 
distributed.

Contrary to popular belief, shareware is a kind of marketing -- not a kind of software.    The 
only conceptual difference between commercial software and shareware is that with 
sharware you are allowed to try the software, for a limited period, before you buy it.

When you install wInformant for the first time, you are automatically granted a 30-day 
evaluation period, during which to determine if wInformant is of value to you.

At the end of the evaluation period, if you continue to use wInformant, you MUST register it.  
Failure to do so is in violation of copyright law and international treaties.
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Why Register?

There are lots of great reasons to register shareware.    Here are just a few reasons for 
registering wInformant:

Reason No. 1 (Registration is Easy and Fast):
Advanced activation code technology now makes instant registrations possible.    With a VISA
or MASTERCARD and a quick, toll-free call you can transform your current UNREGISTERED 
SHAREWARE version of wInformant into the full-featured registered version in seconds.    If 
you don't have a major credit card, simply drop an e-mail line to us and you will receive your
activation code in a flash (usually 24 hours).    If all else fails, fill out the registration form and
send it with check, money order or credit card information via USMAIL.

Reason No. 2 (Additional Features):
Let us say, first of all, that the unregistered shareware version of wInformant is a fully-
functioning and unrestricted product.    It is not crippled in any way.    That said, when you 
register wInformant you get some extra functionality.    Here are a few:

- Multimedia sounds:    If you have a sound card, the registered version of wInformant 
turns your computer into and electronic sound effects machine.    You also get the 
Play Theme button enabled on the About dialog.

-  Splash screen disabling:    The unregistered version is not restricted; however, the 
opening splash screens (or dialogs) can be a bit annoying after a time.    Registering 
allows you to turn off splash screens so wInformant can load faster.    This is 
particularly good if you prefer to load wInformant at startup.

-  Always on top:    Sometimes it is convenient to have wInformant always be the 
topmost window on your desktop.    The registered version has an Always On Top 
menu option.

Reason No. 3 (Technical Support):
wInformant is designed to be powerful yet easy to use.    Users of even the best software 
occasionally require technical help, however.    Registration affords you access to our BBS, e-
mail address and telephone technical support staff.    Do not call for technical assistance if 
you have not registered wInformant.

Reason No. 4 (Free Updates, Big Upgrade Discounts):
Between version major releases, there are likely to be countless interim and maintenance 
releases of wInformant (1.xx).    When you register, you will be able to use your activation 
code again and again to convert shareware versions to licensed versions for free.    And, best
of all, when the next major release is available you will receive big discounts of as much as 
50% on upgrades.

Reason No. 5 (Legalities):
As is stated in the opening shareware license splash, if you use wInformant beyond the 
evaluation period, you must register it.    In other words, if you use wInformant for more than 
30 days without registering it, you are in violation of federal copyright law (and/or 
international treaties).
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How to Register

The cost of registration is $39.00 (US funds only).

Option 1 (Instant Registration):
1. Have your VISA or MASTERCARD ready.
2. Call 1-800-766-6861 (or 1-703-666-9533 outside the USA) and ask for wInformant 

shareware registrations.

Option 2 (Registration by Mail):
1. Print a registration form by pressing the "Print Form" button of the Registration 

dialog, or click on Registration Form at the end of this topic under See Also.
2. Send completed form, along with a check, money order or credit card information, to:

wInformant Registrations
P.O. Box 1126
Martinsville    VA    24114

Option 3 (E-Mail Registration):
1. Create a message containing:    name of registrant; mailing address and VISA or M/C 

number, exp. date and cardholder's name.
2. Send to:

wInformant Registrations
Userid:    72110,3562 on CompuServe

-or-
Internet:    72110.3562@compuserve.com

Option 4 (BBS Registration):
1. Create a message containing:    name of registrant; mailing address and VISA or M/C 

number, exp. date and cardholder's name.
2. Address to: "Sysop" Subject:    "wInformant Registrations"

NOTES: Dont forget to include your return address, no matter which regardless of the 
registration method you choose.

The NEOCOM office is located in Martinsville, VA so be sure to call between 
8am-5pm eastern time.

To get the latest version of wInformant, the best thing to do is to download it 
from the NEOCOM CBB&FL (bbs: 703-666-9535).    

If you do not have access to a modem and would like to have the latest 
version sent out to you on diskette, simply request the diskette and add $10 
for the cost of the diskette plus handling charges.
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Deactivate (Registered Version Only)

The Deactivate button in the lower right corner of the Registration dialog allows you to 
convert a registered version of wInformant back to an UNREGISTERED SHAREWARE version.

You may be wondering why anyone would want to convert a registered version back to a 
shareware version.    Well, the answer is simple.    What if, for example, you had registered 
wInformant and wanted to give a friend a copy to evaluate.    Legally, you cant give them a 
registered version.    Besides, you should not want to have someone else using a copy with 
your name embedded in the title bar anyway.

Just be sure you have your activation code written down somewhere so you can convert 
wInformant back to a registered version.



wInformant Registration Form
To get a hard copy of this form, select File, then Print Topic from the menu at the top of this help window.

Indicate method of payment (payable to NEOCOM Microspecialists, Inc.):
 [ ] Check or Money Order (US Funds Only)

[ ] MastCard      [ ] VISA      Exp. Date __/__    Acct#: ________________________
Signature: ____________________________

Credit card orders: 1-800-766-6861 or FAX 1-703-666-9534 (8am-5pm EST)
For information, or outside the USA, call [voice]: 1-703-666-9533

[    ] Single Copy Standard Registration
Includes activation code only:                   $39.00

[    ] Single Copy Premium Registration
Includes activation code & latest version on diskette: $49.00 (add $5.00 for overseas 
orders)

Bundling & Multi-Site Licensing Options Available
Call or FAX your proposal to 703-666-9533 [voice] or 703-666-9534 [Fax]

Price: $_____.__ x Qty = $_____.__
Overseas or outside USA: $        5.00 = $____5.00 (if applicable)
                                                        Total enclosed:    = $_____.__ (U.S. funds)

Company: ___________________________      User Name: __________________________

Address: ___________________________________________________________________

City: _________________________________            State: ___          Zip: ______-____

Telephone: (        )___-____ Computer:      [ ] AT Class      [ ] 386      [ ] 486      [ ] 
Pentium

Preferred media (if applicable):  [    ] 3.5 in. diskette [    ] 5.25 in. diskette

How did find out about wInformant?    _________________________________________

Comments/Suggestions:

Send this completed form and registration fees to:

wInformant Registrations
c/o NEOCOM Microspecialists, Inc.
P.O. Box 1126
Martinsville VA 24114
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Introduction

Index

wInformant is an advanced utility package and expert system for Windows. You dont have to
be an expert to be able to use wInformant effectively because wInformant is the expert.    Its 
designed to be easy to use, yet powerful.    wInformant takes the drudgery out of many 
everyday Windows housekeeping tasks, such as eliminating redundant .DLL and .VBX files.    
Beginners and experienced users alike will benefit from the many capabiliites of wInformant.

The seven principal utilities include:

This utility finds files fast, and allows you to edit or execute found files with a simple mouse 
double-click.

Provides a quick way to test the status of Windows swap-files.    Also makes 
recommendations about how to improve your existing swap-file situation.

Finds (and optionally eliminates) redundant DLL and VBX files from your hard drive(s).    Only 
exact duplicates are listed for deletion.    Theres even a feature to protect Windows DLL/VBX 
files in the WINOS2 directory of OS/2, if you happen to be using it.

The profile editor allows most .INI modifications to be made in only a couple of keystrokes 
and mouse clicks.    This makes editing .INI files a breeze, and even works with SYSTEM.INI 
files, too.    Also, breaks the 64K limit!

This advanced uninstaller seeks out and selectively (or en masse) wipes out programs, help 
files, .ini files, icons, groups, subdirectories, OLE objects and even system.ini entries.    
FAST!!!

Finally, an easy way to restart Windows.    Like it or not, Windows does occasionally become 
unstable of corrupt.    With this handy feature you can exit, and reload Windows with one 
simple button click.



Hold on to your g-suite; one click of the Eject button and you are on your way to DOS like a 
bat out of Transylvania.    Be careful how you use this feature; however, because some 
applications are not intelligent enough to know their being shut down.    Save your work first.



Moving Around

Although the wInformant client area may resized or maximized, it is not recommended.    
wInformant is designed to be used as an icon bar.    The size of the icon bar automatically 
adjusts depending on the video mode.    You can maneuver the icon bar around the Windows 
desktop in three ways:

Alt-x: To move the wInformant icon bar directly to a specific corner or to the center 
of the desktop press Alt-x, where x is a value between 1 and 5.    For example, 
pressing Alt-1 moves the bar to the upper-left corner.    Alt-2 moves it to the 
upper-right, Alt-3 to the lower-right, Alt-4 to the lower-left and Alt-5 to the 
center of the screen.

Alt-M: Repeatedly pressing Alt-M will cause the icon bar to alternately jump form one
preset location to another, starting from corner number one and working its 
way through to the center location.

Drag: In spite of the fact that there are preset screen locations, there are no 
restrictions as to where you may place the wInformant bar.    To manually 
move the bar click the window title and, as you would with any window, drag 
the bar to the desired location and release.

wInformant always returns to the location where it was last used.    Keep in mind; however, 
that if wInformant is shut down by another application (i.e. shutting down Windows) the 
location settings will not be saved.    In other words, if you want wInformant to remember its 
current location you should close it down using Alt-F4 or equivalent.



Eject button
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Hot Keys:    Alt+C

Eject provides the fastest way out of Windows.

Use Eject when you want to exit Windows in a hurry; however, remember to save your 
important work prior to punching out since there is no prompting.    This is the most 
important difference between Ejecting and exiting Windows normally (File/Exit Windows..., 
Alt-F4, etc.).    With Eject there is no exit prompt.    Once the button is pressed, the exit 
process cannot be stopped.

The Eject button can be disabled by selecting Eject from the View menu.    It is a good idea to
do this when setting up wInformant for an inexperienced user, or if you are concerned about 
hitting Eject accidentally.

IMPORTANT:    Use Eject with caution!



Restart button
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Hot Keys:    Alt+R

Restart provides a quick-and-easy way to exit and restart Windows.

Windows occasionally becomes unstable subsequent to a General Protection Fault or other 
critical error, thus requiring you to restart Windows. Restart provides a convenient way to 
restart Windows using a single mouse click or key combination.

Critical errors are not the only reasons for restarting Windows; a few others might include:

- Modifications to either the win.ini or system.ini files.
- Low memory conditions.
- Video mode changes.

Whatever the reason, Restart is the most convenient way to restart Windows.

NOTE: Save your work prior to restarting a Windows session.



Search

Index

Hot Keys:    Alt+S

Search provides a fast and easy way to find, edit, run or delete files.

Modern, large capacity hard drives are becoming increasingly difficult to maintain.    Search 
can help by simplifying the process of finding lost or missing files.    For example, say you 
need to find a bitmap file that starts with the letters: ST.    To search follow these simple 
steps:

1. Type ST*.BMP in the Search Mask edit box.
2. Enter into the Starting Directory edit box the drive letter and path of where you want 

wInformant to begin its search.
3. Press the Search button.

wInformant will find all matching files, usually in matter of seconds.    The amount of time 
required depends on a number of criteria, including the number of subdirectories traversed 
in the search and the number of matching files.    To speed searches, always remember to 
specify a starting directory.

NOTE: If you dont have a particularly fast video system you may wish to check the 
Turbo checkbox.    This feature temporarily turns off list updating during the 
search.    The only difference you should notice is that you will not see any 
found entries until the search has completed.

During the search, whether you are in Turbo or not, you will be able to watch numbers 
updating in the search statistics section of the dialog (pictured below).

The Dirs field contains the number of directories scanned during the search.    Under File Hits
you will find the number of files found to match the search criteria specified.    Just to the 
right of File Hits is a field called Listed.    This number tells how many of the files that were 
found are actually listed in the answer listbox.    The only time these two numbers are not 
equal is when the number of hits exceeds the maximum the answer list will allow.    Usually, 
this happens somewhere between 1000 and 2000 entries.    The last field in the statistics 
section is labeled Total Bytes and contains the number of bytes (not including FAT overhead) 
consumed by all the Listed files.    This number gives a quick indication of the amount of disk
space you could save by deleting all the listed files.

There are basically three functions available for manipulating listed files in the Search 
dialog:

1. Edit...Loads the selected file into the default editor (i.e. notepad.exe).



2. Delete...Erases the selected file(s).    To select more than one file, hold the Ctrl key 
while moving the mouse cursor from one entry to the next.

3. Open...Runs the selected program.    If the selection file is not an executable, 
wInformant will attempt to load its associated application automatically.

NOTE: Open is an implicit function.    It is called implicit because there is no Open 
button.    To open a file or application, simply double-click your mouse on the 
item you want to run.



Swap-file Check

Index

Hot Keys:    Alt+W

The Swap-file Check performs a quick analysis of your status of your Windows swap-file.

The swap-file, whether it be temporary or permanent, is one of the most important settings 
in Windows.    A bad or poorly chosen swap-file can greatly affect performance.    The Swap-
File Check feature of wInformant makes it a snap to monitor your Windows swap-file.    It tells
what the current swap-file settings are, the status of the existing swap-file and makes 
suggestions about how to improve your swap-file (when appropriate).    It also shows the 
drive, path and filename of the current swap-file.    A button, labeled Change, is provided that
automatically loads Windows Control Panel for easy swap-file modifications.

NOTE: A well-chosen Windows swap-file, especially a permanent one, can increase 
performance by as much as 50% of more.    Dont take this feature lightly.    To 
find out more about swap-files, consult your Windows documentation.



DLL/VBX Redundancy Scan

Index

Hot Keys:    Alt+D

The DLL/VBX Redundancy scan finds, and optionally eliminates, unnecessary dynamic link 
libraries and Visual Basic custom controls.

One of the great benefits of the Windows environment is the dynamic link library (or DLL).    
DLLs allow multiple programs to share a single set of runtime code, without the need to load
multiple copies of the identical code for each application.    This can significantly reduce RAM
requirements under such circumstances.    Visual Basic custom controls, which have the 
extension .VBX are really just specialized dynamic link libraries, and for the sake of this 
discussion are identical.    As nice as DLLs are, they are not always very easy to keep track 
of.

wInformant solves this problem with the DLL/VBX Redundancy scan tool.    DLL and VBX files 
are usually found either in the Windows directory, the Windows system directory or the 
directory of the program that uses them.    Occasionally, we find several copies of the 
identical DLL or VBX files in different locations.    Herein lies the DLL paradox:    They save 
precious RAM and may at the same time be wasting valuable disk space.

The DLL/VBX Redundancy dialog is divided into six sections:

Section 1 (Drive Selection)

The first thing you must decide prior to initiating a scan is which drive letters to include in 
the search.    wInformants expert system automatically highlights all local, non-floppy drives. 
Network drive letters should be displayed but not highlighted.

IMPORTANT: Do not delete DLL or VBX files on network drives unless you are 
absolutely sure that you are the only user that will be affected by such 
deletions.

You may select any combination of drives, local or otherwise.    The maximum number of 
drives that can be selected at any one time is ten.

Section 2 (Status Box)



The status box shown below displays directories during the second phase of the redundancy 
scan.

The redundancy scan process consists of three phases.    The first phase consists of a 
directory scan of each of the selected drives.    In phase two, the all of the system DLLs are 
pushed onto the System DLL/VBXs listbox. Phase three, the final phase, places all the exact 
duplicates in the Redundant DLL/VBXs listbox.

Section 3 (Progress Monitor)

During phase three, the progress monitor displays percent complete graphs.    The graph 
labeled All displays the collective progress of all the drives, while the graph labeled with a 
drive letter (D: in this case) displays the progress of that individual drive.    As the scan 
progresses from drive to drive, the driver letter above the latter changes to match the drive 
currently being scanned.    When only one drive is selected, both graphs display identical 
values.    When both graphs reach the top of their respective columns, the redundancy scan 
is complete.    At this point you can start deleting duplicates.

Beneath the progress monitor is a checkbox titled OS/2 Safe.    This feature is for users of 
OS/2 who run wInformant from standard Windows.    When this box is checked, dynamic link 
libraries found in the \OS2\MDOS\WINOS2\SYSTEM directory are ignored.    If you are 
running OS/2 for Windows, or if you do not have OS/2 on your system at all, then it does not 
matter whether the box is checked or not.

Section 4 (System DLL List)



As previously mentioned, during phase two of a redundancy scan, all of the DLL and VBX 
files in the Windows system directory are pushed onto this listbox.    These DLL files will be 
used for comparison during phase three.    The concept of the redundancy scan is really quite
simple.    If a DLL is in the Windows system directory, then there is no need for that exact 
same DLL to exist anywhere else for a particular machine.

Above and to the right of the list box is a number.    It tells how many entries there are in the 
list.    At the bottom right side of the list there is another number.    It shows the total number 
of bytes in all the files in the list combined.

Section 5 (Redundant DLL List)

When phase three of the redundancy scan completes, the Redundant DLL/VBXs listbox 
contains all the dynamic link libraries that were found to be exact matches with those in the 
System DLL/VBXs listbox.    The term exact match is defined as two files which have the 
same name, date/time stamp and file size.    Although it is theoretically possible for two DLLs
to have the same name, date/time stamp and file size, and yet not be identical, it is 
extremely unlikely.    It is safe to assume that if a file is listed in the Redundant DLL/VBX 
listbox it is OK to delete it.    To delete files, select one or more using the mouse and click the 
Delete button.    

NOTE: Holding the Ctrl key while clicking list entries with a mouse allows you to 
selectively choose entries that are not necessarily consecutive. 



Section 6 (Control Panel)

We have already discussed the function of most of these buttons, but we did not discuss the 
buttons themselves.    The button labeled Scan is used to initiate a redundancy scan, which 
by the way is the primary function of the DLL/VBX Redundancy utility.    Directly beneath the 
Scan button is a button labeled Delete.  It is only enabled when there are entries in the 
redundant listbox, otherwise it will be grayed and inaccessable.    Use the Delete button to 
remove files that are highlighted in the redundant list.    Beneath Delete, you will see the 
Cancel button which, as with any dialog, closes it down .    At the bottom of the list is the 
Help button that loads this context-sensitive help topic.



Profile Editor
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Hot Keys:    Alt+O

The Profile Editor provides an easy, intuitive way to edit all kinds of Windows .ini files, 
including the system.ini file.

Windows .ini files are very useful for application developers and end users alike.    The 
problem is, however, Windows doesnt include a very good facility for maintaining them.    
Profile Editor is designed for exactly this purpose.

The editor dialog may be logically divided into three sections.    The upper left corner of the 
dialog comprises what is known as the file selection section.

Section 1 (File Selection)

As you can see from this snapshot, there are three file selection options: win.ini, system.ini 
and other.    A simple button click on either win.ini or system.ini will load up the respective 
file.    These are the two most commonly used .ini files.    The third option, other, brings up 
the file open dialog with *.ini as the default extension.    Use this feature when you want to 
edit an .ini file other than win.ini or system.ini.

NOTE: When the Profile Editor is activated each time, the win.ini file is automatically 
loaded.

Section 2 (Section Selection)



The upper right portion of the Profile Editor dialog is devoted to Section Selection.    For those
of you new to the concept of Windows .ini files, a section is a header line in an .ini file that is 
surrounded by ([ ]) brackets.    Sections are usually followed by one or more key lines.

A sample section as it would appear in a text editor (i.e. NOTEPAD.EXE) is shown below:

[wInformant]
RECTLeft=196
RECTTop=369
ScreenPosition=6
LaunchApp=D:\COMMWORK\LL5\LL5.EXE
LaunchNoAsk=N

A number of profile (or .ini) editors are currently available both in shareware and through 
commercial channels, but many of those are unable to edit the system.ini file.    This is 
because most other similar programs rely on the Windows API for profile editing system 
calls.    If all .ini files were the same there wouldnt be a problem with that.    Unfortunately, 
system.ini is different from other .ini files in that its key values (values on the left side of 
the = sign) do not have to be unique.    There are many instances of device=, to be found 
within the system.ini, particularly in the [386Enh].    This is a problem for most other .ini 
editors, but not with wInformants Profile Editor.



Uninstall
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Hot Keys:    Alt+U

Uninstall provides a powerful and user-friendly facility for removing unwanted Windows 
applications, their associated dynamic link libraries (DLLs), win.ini and system.ini file 
entries, Program Manager icons and groups.

Windows applications are often more difficult to remove than they are to install. Sooner or 
later we all have to delete a Windows application to make room for other programs.    The 
problem is, there are sometimes entries made to the win.ini or system.ini files which 
would not be deleted if we simply delete the program or directory.    The best way to remove 
a Windows program is with the programs own uninstall program.    Unfortunately, most 
programs dont include such a tool.    Hence, we now have wInformant - Uninstall. Windows 
has a 64K .ini file limitation which means it is crucial to get rid of unnecessary entries 
periodically.    Uninstall takes care of this automatically, too.

The Uninstall dialog consists of four logical sections.    The upper left corner of the dialog 
comprises what is known as the group selection section.

Section 1 (Group Selection)

The first step in deleting an application with Uninstall is to select a program group from the 
Program Groups listbox in the upper-left corner of the dialog.    The snapshot at left shows a 
sample list.    Note that each group name corresponds to an actual program manager group.  
As soon as you select a group, the applications list is automatically updated with all the 
icons titles for programs in the group.

Another point of interest in the group selection section is the No Prompting checkbox.    
Unless you are quite sure of what you are doing, it is a good idea to leave this feature 



unchecked.    For safety reasons, the checkbox always defaults to unchecked.    When 
checked, the No Prompting feature bypasses all delete safety warnings.    This can be a 
time saver if you are confident enough to use it, but it can be very hazardous.

Finally, the group selection has a button labeled Browse, allowing you to uninstall programs
that are not in program manager groups.    This is of particular importance to users of third-
party shell replacements, such as the Norton Desktop™.    As a matter of fact, you can even 
use Browse to remove DOS programs.

Section 2 (Program Selection)

The second step is to select the specific application from the Program Selection listbox.    The
Program Selection section is easily identified by its icon-embedded list.

Identifying applications is easy using wInformant Uninstall icons.    Despite the unique look of
the Program Selection listbox, it functions exactly like a normal listbox.    Simply scroll to the 
icon/program name you want to delete and click it once with the left mouse button.    Once 
you have selected an application it is time to initiate the analysis by pressing Probe.    

At the top of the Program Selection listbox you will notice a title bar.    The title bar also 
functions as an information toggle.    Press the title bar once to display the full path and 
filename of the .grp file currently selected. Press it again to return to the group title.

NOTE: Double-clicking your selection is a shortcut equivalent to clicking once and 
then pressing Probe on the Control Panel (discussed in next section).

Section 3 (Control Panel)



The third and fifth steps of the uninstall process, as well as a few other miscellaneous things,
are performed here.    The third step, which you might already have performed by double-
clicking as described in step two, is to press the Probe button.    This causes wInformant to 
search for programs, directories, associations and other win.ini and system.ini entries.    
The fourth step is to select purge operations from the purge queue, and is discussed in the 
section 4. The fifth and final step in the uninstall process is to press the Uninstall button.    
When you press Uninstall, if the No Prompting checkbox is checked then the uninstall 
process begins without warning.    If No Prompting is not checked (this is the default) the 
process begins, but a warning message box is displayed prior to each purge operation.

The five buttons of the control panel are described below:

Help: Loads load context-sensitive help.

Cancel: Closes the Uninstall dialog and returns to wInformant.

Open: The Open button loads and runs the program, if one is listed, in the Purge 
Queue.    This feature is useful if you want to be sure the program you are 
about to uninstall is actually the one you think it is, for example.

Uninstall: Initiates the uninstall process.    This button is usually the last step in the 
uninstall process.

Probe: Searches for programs, .hlp and .ini files, directories, associations and other
.ini file entries.    Found items are listed in the purge queue as described in 
section 4.

Section 4 (Purge Queue)

The Purge Queue is essentially a list of purge operations which, if highlighted, will be 
performed during the uninstall process. This is the fourth step of the uninstall process.



Certain purge operations are automatically selected while others are not.    wInformant 
attempts to preselect items which are least likely to result in ambiguities.    The remaining 
operations may be manually selected as desired.    

NOTE: You should select purge operations prior to pressing the Uninstall button.    If 
you do skip this step you will probably not be getting rid of everything you 
need to.    Take plenty of time to scan through the purge queue.

You may have noticed two small buttons immediately above and at the right side of the 
purge queue labeled All and Clr.    These provide a quick method for highlighting all or 
clearing all purge queue entries, respectively.    If there are standard Windows or common-
use DLLs, then All does not highlight these entries.    You may manually override this safety 
feature by manually selecting entries as desired.



File menu commands

The File menu offers the following commands:

Eject Shut down Windows
Restart Restarts Windows
Options Allows you to make changes to the default settings 

for such features as sound effects and splash 
screens (registered version only)

Exit Exits wInformant.

Process menu commands

The Process menu offers the following commands:

Search Searches for and manipulates found files.
Swapfile Check Restarts Windows
DLL/VBX Search Scans for redundant DLL/VBX files.
Profile Editor Facilitates painless .ini file maintenance
Uninstall Finds and wipes out applications and their associated files 

(i.e. .HLP, .INI, DLL, etc.)

Options command (File menu)

Use this command to access the registered version-only submenu options:

-  Splash Screens:    The unregistered version is not restricted; however, the opening 
splash screens (or dialogs) can be a bit annoying after a time.    Registering allows 
you to turn off splash screens so wInformant can load faster.    This is particularly 
good if you prefer to load wInformant at startup.

- Sound Effects:    If you have a sound card, the registered version of wInformant 
turns your computer into and electronic sound effects machine.    You also get the 
Play Theme button enabled on the About dialog.

-  Always On Top:    Sometimes it is convenient to have wInformant always be the 
topmost window on your desktop.    The registered version has an Always On Top 
menu option.



View menu commands

The View menu offers the following commands:

Move Moves the wInformant toolbar through all the 
preset locations.

Eject Toggles the Eject button on and off.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get 
help.

Using Help Provides general instructions on using help.
Shareware 
Notice

Gives information about the shareware concept.

Registration Gives registration information.    Also, allows you to 
enter an activation code to convert to the full 
registered version.

About Displays the version number of this application.



Exit command (File menu)

Use this command to end your wInformant session.    You can also use the Close command 
on the application Control menu.    wInformant prompts you to save documents with unsaved
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using wInformant and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice, version number and licensing information 
of your copy of wInformant.



Context Help command 

Use the Context Help command to obtain help on some portion of wInformant.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the wInformant window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< wInformant >>

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the wInformant window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>




